RocketPort® Serial Hub Si
Driver Installation for Windows 95/98®
How to Use this Document
You can use the interactive Table of Contents to locate the information you need.

Driver Requirements
This document discusses installing and configuring the RocketPort Serial Hub Si device driver for the
Windows 95/98 operating system. The RocketPort Serial Hub Si requires at least one personal computer
configured for local area networking and running one of the following operating systems:
•

Microsoft® Windows® 95, all versions

•

Microsoft® Windows® 98, Release 1 or Release 2

Note: The driver for the RockPort Serial Hub-Si is different than the driver for the RocketPort Serial Hub
and they are NOT interchangeable. See the ftp/web site for driver support for other operating systems.
For hardware specific information or the product overview, see the Hardware Installation documentation that
is available on the Comtrol CD or you can download the current version from the ftp/web site.
Comtrol documents are available in electronic form on the Comtrol ftp/web site. Driver updates can be
downloaded at no charge from the Comtrol ftp/web site. Always check the web or ftp sites to make sure that
you have the current driver and documentation. Software downloaded from the ftp/web site are selfextracting zipped files that you must extract before installing.

Connectivity Requirements
You will need an Ethernet connection, to either to an Ethernet hub or to a network interface card (NIC) in the
host computer. See the Hardware Installation documentation for information regarding hardware
installation, including building crossover cables.
Note: If connecting the RocketPort Serial Hub Si directly to the NIC card in the computer, an Ethernet
crossover cable is required.

Initial Installation - Quick Reference
Use the Hardware Installation documentation to install the hardware for the first time or you can use the
following installation outline:
1. Connect the RocketPort Serial Hub Si to a network hub or NIC card.
2. Connect the power adapter to the RocketPort Serial Hub Si and plug it into an electrical source.
3. Power-up the RocketPort Serial Hub Si and verify that it passes the power-on diagnostics (see the
Hardware Installation documentation).
4. Connect the serial devices.

Caution

The RocketPort Serial Hub Si defaults the ports to RS-232. Do not connect devices that require a
specific mode (RS-422 or RS-485) until the port has been configured in the device driver.

5. If necessary, unzip the device driver file, see Extract.htm.
6. Remove the existing driver.
7. Install and configure the new version of the driver.
8. Shut down and restart the server.
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Driver Installation and Configuration
This subsection discusses the following installation and configuration issues:
•

Removing an existing device and driver (discussed below)

•

Installing the software

•

Verifying the installation

•

Using port sharing

•

Changing configuration parameters

•

Adding new RocketPort Serial Hub Si devices to an existing configuration

•

“Hot-swapping” devices

See Initial Installation - Quick Reference, if you want to install the product using a quick reference.

Removing an Existing Device and Driver
Use the following procedure to remove any existing RocketPort Serial Hub Si devices and drivers on the
Windows 95/98 operating system. If updating (not reconfiguring) the driver, you may skip Steps 1 through 8
and leave the devices installed, but make sure that you remove the existing driver before installing an
updated driver.
1. Right-click on My Computer, and select Properties.
2. Select the Device Manager tab.

3. Expand the Multi-function adapters node of the device tree.
4. Highlight RocketPort Serial Hub Si 4/8 Port Device.
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5. Click the Remove button. This warning displays:

6. Click the OK button. Wait while the operating system deletes the device record. When it is finished, an
updated Device Manager window displays.
7. Repeat Steps 4 through 6 for each RocketPort Serial Hub Si in the system.
8. When finished removing devices, click the Close button.
9. Click the Start button to begin removing the software.
10. From the Start menu, select Settings, then Control Panel.
11. Double-click on the Add/Remove Programs icon. A list of installed programs displays:

12. Highlight Comtrol RPSH-Si Tools and click the Add/Remove button. The programs are removed.
13. Click the OK button.
14. Using Windows Explorer, delete the RPSHSI directory and all files it contains. This directory is typically
located in the C:\WINDOWS\SYSTEM directory.
15. To ensure a completely clean installation, you can view the \WINDOWS\INF directory and use the
Windows Explorer Tools, Find, Advanced option to search for and erase all files with names beginning
with “OEM” and containing the text “ctmrphsi.” However, this is not required, and these files do not
exist in some versions of Windows.
16. Restart your computer so that your changes take effect.
After removing the existing driver, use the following subsection to install a new version.
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Installing the Device and Driver
Use the following procedures to install the device and driver for the Windows 95/98 operating systems.
Note: If updating the driver, first remove the existing version of the driver. Do not use the Update option.
The following procedures assume that you have already:
•

Installed the hardware

•

Determined that the hardware is working properly using the power-on diagnostics

See the Hardware Installation documentation for all hardware and diagnostics information.
Note: In a new installation, the lower 10BASE-T LED should be lit (if using a 10Base-T Ethernet connection)
and the Port 1 LED should be flashing (waiting for the driver to load).
1. If necessary, extract the driver files by double-clicking on the driver file name and saving it to a diskette
or a new subdirectory on your hard drive. For example: c:\comtrol.
2. Click the Start button, and select Settings, then Control Panel.
3. Double-click on the Add New Hardware icon. The following screen appears:

4. Click the Next button. You are asked if you want Windows to search for new hardware:

Installing the Device and Driver
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5. Click the No button, then Next. The list of hardware types displays:

6. Highlight Multi-function adapters and click Next. The list of manufacturers and models displays:

7. Click the Have Disk button. This window displays:

8. Enter the drive and directory path to the installation files and click the OK button. For example, if you
extracted the driver to a subdirectory named comtrol, enter: c:\comtrol.
If using the Browse option to locate the installation files, select the ctmrphsi.inf file.

Installing the Device and Driver
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A list of RocketPort Serial Hub Si devices displays:

9. Select your hub type (4- or 8-port) and click Next. The following window displays:

10. Click Finish. The system begins copying files and building the driver database:
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11. Click Yes when asked if you want to restart your computer:

12. After the computer restarts, it automatically recognizes the new COM ports and installs the software for
each port. When the process is complete, this message displays:

13. Click Yes. The Comtrol Main Setup window displays:

14. Make sure the RocketPort Serial Hub Si device is selected, then click the Properties button.

Installing the Device and Driver
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The Device Setup window displays:

15. Optionally, rename the RocketPort Serial Hub Si default device name.
16. Verify the Number of Ports you want to configure for this computer.
17. Select the type of network addressing that you plan to implement.
Note: See Hardware Installation for information regarding the advantages of MAC or IP addressing.
a. If you select MAC, enter the MAC Address of the device that you are installing.
Note: The MAC address label is on the bottom panel of the device and the format is: 00 c0 4e 06 xx xx
Once connected to the network and powered up, most Comtrol network devices broadcast their MAC
addresses. After the initial installation, you can use the droplist to view and select MAC addresses.
b. If you select IP, enter the IP Address of the device that you are installing.
Note: IP addresses must be DHCP assigned or by using the IP Configurator program. For more
information, see Hardware Installation.
c. Once you select an addressing method, you must “un-click” the selected method in order to select the
other method.

Installing the Device and Driver
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18. Click the OK button. The Main Setup window appears:

19. If you want to change the Send Window or Scan Rate, click the Options tab. The Options screen appears:

a. Select the options you want to implement. Small Send Window causes the driver to send small data
packets immediately, rather than waiting until the send buffer fills.
b. Scan Rate is used to adjust latency for time-critical applications. Typically, you should leave it set to
the default value of 10 milliseconds.
20. Click the Main Setup tab.

Installing the Device and Driver
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21. Highlight any COM port that you want to configure and click Properties. The Port Properties window
displays:

22. Select the appropriate mode to match the peripheral that you are connecting to the selected COM port.
23. Optionally, make any necessary changes to fit your environment:
a. Lock the baud rate to access higher or lower rates than are normally permitted by your Windows
applications.
b. Set a time delay on the transmit data before a port closes.
Note: You can select the length of time to wait for data to clear the transmit buffer, before a host
application closes the port. If data is still in the transmit buffer, you can set a delay time to allow
the buffer to empty. This is typically used with slower peripheral devices such as printers, to give the
data sufficient time to flush through the system.
c. Map 2 stop bits to 1.
Note: You can use this option to map 2 stop bits to 1 bit. If the application you are using is hard coded to
use two stop bits and you are receiving framing errors, you can implement this option. Leave this
box unchecked to enable stop bits to pass through unchanged.
d. Wait for physical transmission before completing write.
Note: Use this option to force all write packets to wait until the transmit data has physically completed
the transmission before returning completion to the host application. The default mode (box not
checked) is to buffer the data in the transmit hardware buffer and return completion as soon as the
packet is in the buffer.
e. Emulate modem hardware ring signal.
Note: This emulates a hardware RI (ring indicator) signal.
f. Clone port settings.
Note: If this box is checked, the changes you make in the COM Properties screen are applied to all ports
on this serial hub. If this box is not checked, the changes you make to the Port Setup options apply
to the selected port only.
g. COM name.
Note: Use the droplist to select the desired COM name for the selected port. Port numbering is defined by
the computer controlling the port and is neither automatic nor required to be sequential. Be careful
not to overlap port numbers (for example, by creating two “COM6” ports), as this will disable the
affected ports.
You can select Not Configured, if you do not want this port available on this particular
installation.

Installing the Device and Driver
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h. If you need to configure RTS options, click on the RS Toggle tab.

i.

Configure the port.
The Override and lock to RTS toggle mode option allows you to lock the port in RTS toggle mode,
then set the mode (low or high) as desired.
The RTS Toggle RTS Low option allows you to toggle the RTS output signal low during data
transmission. If the option box is not checked, RTS is toggled high (asserted) during data transmission

24. After configuring your port (COM) properties, click the OK button. The Main Setup screen returns.
25. If you did not clone all the COM ports, repeat Steps 21 through24 until all of the COM ports that you
want to use are configured.
26. Click on the OK button after configuring each port.
27. When you are finished configuring ports, click OK to save your changes and exit from the Main Setup
window. At this point, you should be ready to begin operations. No rebooting is necessary.
Each RocketPort Serial Hub Si must be added individually.
•

To add another RocketPort Serial Hub Si, repeat the above procedure.

•

To complete configuration, you may need to set up modems or printers. See the appropriate subsections
later in this document.

Installing the Device and Driver
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Verifying the Installation
After rebooting the system, the driver downloads to the RocketPort Serial Hub Si. The port LEDs should be
cycling their lights approximately every 30 seconds (instead of the Port 1 LED flashing, which indicates that
the RocketPort Serial Hub Si is waiting for the driver).
Use the following procedure to verify the installation.
1. Open the Device Manager.
2. Expand the Multi-function adapters entry.
3. Select the RocketPort Serial Hub Si.
4. Click the Properties button.
5. Check the Device status.

If the installation was successful, the status message should indicate that the device is working properly.
Note: This message is only meaningful if the hardware LED diagnostics pass. See the Hardware
Installation documentation.
If the status message indicates a problem, check the device as outlined in Troubleshooting. In addition, you
can use the following applications to help diagnose the problem:
•

Using Test Terminal

•

Using Port Monitor

•

Using the Device Advisor

Verifying the Installation
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Using the Port Sharing Feature
The RocketPort Serial Hub Si can be shared with multiple computers on a network. To do so, follow the
Installing the Device and Driver discussion for each server that you want to permit access to the serial ports.
You can implement the port sharing feature in several ways. You share the same port with multiple servers
or you can set up multiple servers to share specific ports on the RocketPort Serial Hub Si.

Example of Using the Port Sharing Feature
RocketPort Serial Hub Si
Port 1
Port 2
COM 5
COM 6

Configured
for Server A

Port 3
COM 5

Port 4
COM 6

Configured
for Server B

Ethernet Hub

Server A

Server B

COM port names must be unique to each server. Multiple servers can
use the same COM port names, if desired.

When installing the driver on Server A, select “Not Configured”
for the COM names on Ports 3 and 4. When installing the driver
on Server B, select “Not Configured” for the COM names on
Ports 1 and 2.

Note: Most applications do not release ports, so you may not be able to use port sharing across multiple
servers with the same port. Also, if using port sharing, make sure that two computers do not try to access
the same port at the same time. Only one computer can control a given port at a given time.

Using the Port Sharing Feature
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Changing Configuration Parameters
Use the following procedure to change the:
•

RocketPort Serial Hub Si properties, such as:
- Name of the RocketPort Serial Hub Si
- Number of ports
- Network address
Note: You can change the network address type by clicking on the current checkbox type, followed by
placing a check in the other network type and entering the appropriate address. You also have to
change the MAC address if hot-swapping the hardware.
- Device options such as scan rate.

•

COM port properties, such as the port mode (RS-232, RS-422, or RS-485) and application-related options
discussed in Step 23 of the installation process.
Before changing the communications mode in the Setup program for an existing port, make sure
that you disconnect the peripheral device from the port.
Caution

Use the following procedure to change configuration parameters.
1. Right click on the My Computer icon and select Properties. The System Properties window displays.
2. Click on the Device Manager tab.
3. Expand the Multi-function adapters entry.
4. Select the RocketPort Serial Hub Si.

5. Click the Properties button. The Device Properties window displays.

Changing Configuration Parameters

16

6. Select the Device Setup tab.

7. Click the Configure button. The Main Setup window displays:

Changing Configuration Parameters
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8. To change basic driver-level options (scan rate, send window size), click the Options tab.

9. Make your changes, then click on the Main Setup tab to return to the Main Setup page.
10. To change the RocketPort Serial Hu Si properties (device name, number of ports, or network address),
highlight the device name and click the Properties button. The Device Setup window displays:
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11. Make the desired changes and click OK to return to the Main Setup page.

12. To change port configuration, highlight the COM port that you want to change and click the Properties
button. The Port Setup window displays:

13. Make the port configuration changes that you want and click the OK button.
Before changing the communications mode in the Setup program for an existing port, make sure
that you disconnect the peripheral device from the port.
Caution

If you change the mode of the port, the following query appears:
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14. Click OK to save your configuration changes and return to the Main Setup window.

15. Click OK to close the setup program and return to the Windows Device Manager.
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16. Click OK to exit to the Windows System Properties window.

17. Click OK to exit to the Windows desktop.
Note: Depending upon the type of configuration changes you made, you may or may not need to reboot your
system. The driver will prompt you to reboot the system, if necessary.

Adding RocketPort Serial Hub Si Units After the Initial Installation
Each RocketPort Serial Hub Si must be installed as a separate Multi-function adapter. Use the following
procedure to add more RocketPort Serial Hub Si units to an existing installation.
1. Connect the new RocketPort Serial Hub Si to the network and power it up.
2. Make sure that the RocketPort Serial Hub Si passes the power-on LED diagnostics.
3. Go to Installing the Device and Driver and repeat the entire procedure.
4. Reboot the system so that the new RocketPort Serial Hub Si initializes.

Adding RocketPort Serial Hub Si Units After the Initial Installation
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“Hot-Swapping” RocketPort Serial Hub Si Devices
On occasion, it may be necessary to replace an existing and configured RocketPort Serial Hub Si with an
identical hub, without downing the server or reconfiguring ports. To do so, follow these steps:
1. Shut off the old RocketPort Serial Hub Si, connect all cables to the corresponding ports on the spare
RocketPort Serial Hub Si, and power up the new RocketPort Serial Hub Si.
Note: Transfer all cables on a port-by-port basis so that the cables are not accidentally switched.
2. Write down the Network (MAC) Address of the spare RocketPort Serial Hub Si on the customer service
label provided.
3. Right-click on the My Computer icon and select Properties.
4. Select the Device Manager tab.
5. Expand the Multi-function adapters and select the RocketPort Serial Hub that you are swapping out.
6. Click the Properties button.
7. Select the Device Setup tab and click the Configure button. The Main Setup window displays:

“Hot-Swapping” RocketPort Serial Hub Si Devices
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8. Make sure the serial hub is highlighted and click Properties. The Device Setup window displays:

9. Enter the network (MAC or IP) address of the replacement RocketPort Serial Hub Si.
Note: Leave all other settings the same. The unit being swapped in must have the same number of ports and
the same COM number configuration as the unit being taken out of service. If you use IP addressing, the
new unit may be configured to use the same IP address as the old one.
10. Click OK to exit to the Main Setup window.
11. Click OK to exit to the Windows Device Manager.
12. Click OK to exit to the Windows System Properties.
13. Click OK to exit to the Windows desktop.
The new RocketPort Serial Hub Si immediately replaces the old one under the old hub’s device name.
Note: Restarting the system is not needed, however, the RocketPort Serial Hub Si may need to have the power
turned off and then back on.

“Hot-Swapping” RocketPort Serial Hub Si Devices
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Configuring Modems
After installing the hardware and driver for Windows 95/98, use this discussion to configure modem COM
ports.
The RocketPort Serial Hub Si can support any asynchronous serial modem for use by any application that
uses TAPI. For information regarding port pinouts and signals, see the Hardware Installation Card.

Installing Modems
The following instructions were developed using Comtrol modem products. If you are using another brand of
modem, note that some prompts and screen descriptions may differ from those shown.
Follow these steps:
1. Connect the modem to the desired port.
2. Power up the modem.
3. Open the Control Panel window.
4. Double-click the Modems icon.
If you have no other modems installed, skip to Step 5.
If you have already installed another modem, the Modems Properties window displays. Click the Add
button.

Installing Modems
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5. Check the “Don’t detect my modem...” box and click Next.

Note: Do not use the auto-detect feature. The Windows modem auto-detect function does not recognize
ports above COM10, and it scans down, beginning with the highest detected COM port. This can
produce extremely confusing modem-to-port numbering and naming sequences.
6. Select the appropriate manufacturer and model and click Next. If the correct manufacturer and model do
not appear on the list, click Have Disk to install software from a manufacturer-supplied installation
diskette.

Installing Modems
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7. Select the port to which the modem is attached and click Next. The system installs the modem software.

8.

Select Finish.

Installing Modems

26

9. The Modems Properties window displays again. Depending on prior configuration, you may be asked to
enter your country of use, area code, number dialed to get an outside line, and whether you have tone or
pulse dialing.

10. If you need to configure modem properties (maximum baud rate, data bits, parity, and so on), click the
Properties button, make the needed changes, then click OK to return to this window.
Note: For help configuring modem properties, see the Windows Help System.
11. If you need to configure dialing properties (country, area code, calling card number, and so on), click the
Dialing Properties button, make the needed changes, then click OK to return to this window.
12. Click Close to exit the Install New Modem wizard. Your changes take effect immediately. No reboot is
required.

Installing Modems
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Configuring Printers
Use this subsection to configure printers for the RocketPort Serial Hub Si after installing the RocketPort
Serial Hub Si hardware and driver.

Adding Serial Printers
Follow these steps to configure a serial printer.
Note: You may need the Windows 95/98 CD-ROM in order to load drivers and complete printer installation.
Make sure you have this CD on-hand before beginning the process.
1. Connect the printer to the desired port. Use a DTE-to-DTE null modem cable unless the printer maker
specifies otherwise.
2. From the Start button menu, select Settings, then Printers.

3. Double-click on the Add Printer icon. The Add Printer Wizard starts.

4. Click Next.

Adding Serial Printers
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5. Select Local printer, then click Next.

Note: While the RocketPort Serial Hub Si is a network device, the COM ports appear to be local ports to your
computer.
6. Select your printer make and model and click Next, or use the Have Disk option to load a printer driver
from CD or diskette.

Adding Serial Printers
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7. Select the COM port to which the printer is connected and click Configure Port.

8. Enter the baud rate, flow control, and other information as specified by the printer manufacturer, and
click OK.

Adding Serial Printers
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9. The port selection page displays again. Click Next.

10. Optionally, enter a custom name for this printer, and select whether this printer is the Windows default
printer. Click Next.

11. Select whether to print a test page and click Finish.
Note: You may be prompted to insert the Windows 95/98 CD-ROM in order to load drivers. Do so and follow
the on-screen instructions.
12. If the test page prints successfully, you are now ready to begin using the printer. No reboot is needed.

Changing Printer Port Configuration
If the printer does not successfully print the test page, it may be necessary to change the port baud rate,
parity, and so on. If the Ports applet does not configure the port properly, you may have to use the mode
command from a DOS prompt. Also, check the printer for DIP switches or other hardware configuration
options.

Changing Printer Port Configuration
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Changing Printer Port Assignment
To change the port assigned to a printer, follow these steps:
1. Open the Printers control panel.
2. Right-click on the icon for the printer you want to change.
3. Select the Properties option from the menu. The Properties window is displayed.
4. Click the Details tab.
Note: The Properties window also gives you access to printer test and setup options that can be very
helpful when debugging a serial printer installation.
5. Use the droplist to select the port you want to switch to. Remember to change your cabling accordingly.
6. Click on the OK button. Any changes you make take effect immediately. No reboot is needed.

Changing Printer Port Assignment
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Troubleshooting and Using Comtrol Tools
The first subsection discusses troubleshooting. The following subsections discuss the following utilities that
are shipped with Comtrol drivers for Microsoft operating systems:
•

Test Terminal (WCOM32.EXE)

•

Port Monitor (PORTMON.EXE)

•

Device Advisor

Troubleshooting
If you are having trouble with a RocketPort Serial Hub Si, try the following.
Note: Most customer problems reported to Comtrol Technical Support are eventually traced to cabling or
network problems.
1. Verify that the unit is powered on. Turn the unit’s power switch off and on, while watching the LED
diagnostics. See the Hardware Installation documentation for information about the LEDs and running
the diagnostics program.
Note: If the Port 1 LED is flashing, this indicates that the driver has not downloaded to the unit. If you
believe that the server’s configuration is correct, then there is probably a network problem.
2. Verify that the port polarity is correct, see the Hardware Installation documentation.
3. Verify that you are using the correct types of cables in the correct places and that all cables are connected
securely.
4. Reboot the server.
5. If you are using a 10/100mb NIC card, try locking the card to 10mb/s.
6. Verify that the Ethernet hub and any other network devices between the server and unit are powered up
and operating.
Note: To isolate the unit from the network, use a “crossover” ethernet cable to connect the unit directly to
the server.
7. Verify which servers are having problems controlling the device.
8. Verify that the network (MAC) address in the driver matches the address on the RocketPort Serial Hub Si
(See Changing Configuration Parameters.)
9. Verify that the network IP address is what the RocketPort Serial Hub Si acquired from the DHCP server
or was manually entered. If IP addressing is being used, the server should be able to ping the RocketPort
Serial Hub Si.
10. Verify that you are addressing the port correctly. In many applications, device names above COM9 require
the prefix \\.\ in order to be recognized. For example, to reference COM20, use \\.\COM20 as the file or
port name.
11. Use the Test Terminal program (wcom32.exe) to troubleshoot communications on a port-by-port basis.
(See Using Test Terminal.)
12. Use the Port Monitor program (portmon.exe) to check for errors, modem control, and status signals. In
addition, it provides you with raw byte input and output counts. (See Using Port Monitor.)
13. Use the Device Advisor to help identify the problem. (See Using the Device Advisor.)
14. If you have a spare RocketPort Serial Hub Si, try “hot-swapping” RocketPort Serial Hub Si units. If this
corrects the problem, the RocketPort Serial Hub Si you have removed from service may be defective or in
need of repair.
15. Remove and reinstall the driver.
16. If you are unable to resolve the problem, see Technical Support for information on contacting Comtrol.
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Using Test Terminal
WCOM32 is a terminal program that enables you to open a port, send characters and commands to the port,
and toggle the control signals.
Note: WCOM32 will not work if any other application is using the port.
Follow these steps:
1. To start WCOM32, select Test Terminal from the Comtrol program group. The program window displays:

2. Select Open Port from the Port menu. A list of possible COM port numbers displays.
3. Select the COM port you want to test.
If the COM port does not exist or if it is currently being used by another program, a Create File Error
message displays.
If the COM port is available, a terminal window pops up:

Note: Notice the <loop> button in the terminal window. If this option is activated, it is green and uppercase
(
), the COM port internal loopback feature is activated, and the data is returned by the COM port
hardware. If this option is deactivated, it is gray and lowercase (
), the internal loopback is
deactivated, and the data is sent out the COM port.

Using Test Terminal
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Testing a RocketPort Serial Hub Si
1. Place a loopback plug on the COM port you are testing. Make sure all connectors are seated firmly and that
the loop button is off.
Note: This works only for RS-232 and RS-422 mode. Use the diagnostics for RS-485 mode.
To build loopback plugs, see the Hardware Installation documentation.
2. From the Port menu, select Send Test Data. The program sends out a repeating data stream.
Note: To stop the data stream, select Send Test Data again.
•

If the loopback plug is in place and the port is working correctly, the test data should be echoed back
to the screen.

•

If the loopback plug is not in place or the port is not working correctly, no data or garbled data is echoed
back to the screen.

Note: If no characters appear, try putting the loopback plug on an adjacent port. It may be that you have
the ports mixed up.
3. If further testing is required, select Loopback Test from the Port menu.
If the loopback plug is in place and the port is working correctly, the system should return the message
“Passed.”

If the loopback plug is not in place or the port is not working correctly, the system will return the message
“Failed.”
Modem Control Signals
The terminal window displays the modem control signals as gray or green lights at the top of the window. The
first four are inputs:
The lights are green if they are turned on, or gray if off. The text on the light also changes from uppercase
(CTS), which is on, to lowercase (cts), which is off.
The next two lights are outputs:
Note: If you have a loopback plug connected and you click on one of the outputs, the corresponding signal is
sent to the input and the input lights should toggle accordingly.
The rightmost light is the loop indicator:
If this is on, the COM port internal loopback feature is activated and any information or code entered in the
terminal window loops back through the COM port circuitry. If this is off, the COM port internal loopback is
deactivated, and any information or code entered in the terminal window is sent out of the port.

Using Port Monitor
The Port Monitor program (portmon.exe) offers a summary of all RocketPort Serial Hub Si statistics in one
spreadsheet view. It also enables you to verify operation of all RocketPort Serial Hub Si ports from a single
window.
The Port Monitor display follows the familiar spreadsheet model: each COM port is a horizontal row, and each
vertical column displays a variable or value for the respective COM port. For definitions of the abbreviations
used, see the Port Monitor Variable List.
Port Monitor can also produce statistics and reports that can help you verify the operation of the COM ports
and connected peripherals.
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Some immediate feedback includes:
•

The state of the modem control and status signals

•

Open ports

•

Raw byte input and output counts obtained from the driver

•

Port errors

The available statistics include:
•

Instantaneous characters per second (CPS) calculations

•

Minute, hour, and day CPS averages and peaks

•

Carrier detect (CD) signal runtime and transition count

Reports can be automatically generated on an hourly and/or daily basis, and can cover all ports collectively or
a separate report for each port. You can also set how often the values are recalculated, fine-tuning
thoroughness against system efficiency, and automatically run external batch files to perform additional
processing and analysis.
Starting Port Monitor
To run Port Monitor, select Port Monitor from the Comtrol program group.
The monitor window displays:

Note: To change the appearance of the screen, see the following discussion.
Once the monitor window displays, Port Monitor is active and collecting data. If any cumulative data has
been saved from previous sessions, it is automatically brought in and used.
Port Monitor continues to run and collect data until you terminate it, at which point all accumulated data is
automatically saved for use in the next session.
Changing Screen Appearance
While Port Monitor is running, there are a number of commands and controls that change the appearance of
the screen.
Port Monitor Screen Commands

Desired Change

Procedure

Change the monitor window font.

Select Font from the Edit menu.

Change width of a single column.

Left-click on the column separator (vertical) line and drag it to the
desired width.

Change column placement.

Left-click in the middle of the column you want to move and drag it
to the desired location.

Remove a column.

Right-click on the column you want to remove and select Remove
from the pop-up menu.

Clear all fields and reset them to null Right-click on the upper left cell in the table and select Reset from
values.
the pop-up menu.*
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Port Monitor Screen Commands (Continued)

Desired Change

Procedure

Clear any single field except the upper Right-click on the field to be cleared and select Reset from the popleft cell.
up menu.*

Add a column.

Right-click on the column now occupying the desired location and
select Add from the pop-up menu.
You are prompted to name the variable you want to display, as well
as other information. (See Column Setup, below.)
After you click OK, the column is inserted in the selected location
and the existing column is moved to the right.

Right-click on the column and select Properties from the pop-up
Change other properties of a column. menu. (See Column Setup, below.)
* The Reset command does not clear raw data from the calcs.dat file. It simply resets the selected display fields
to their null values. For more information regarding calcs.dat see page 39.
Column Setup
When you select Add or Properties from the column pop-up menu, the Column Setup window displays:

•

Use the Input droplist to select the variable displayed in the column.

•

Use the Type droplist to select the way in which the value displays: either as an integer, as an on/off state,
as an integer with a kilo, mega, or giga suffix, or as an hh:mm:ss time stamp. This defaults to the
appropriate type for the selected Input variable.

•

Use the Name variable to change the column heading name.

•

Use the Width variable to specify the column width in characters.

•

Use Color0 to set the column character color when the value is zero.

•

Use Color1 to set the column character color when the value is not zero.

•

When done, click OK to save your changes and return to Port Monitor.
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Report Configuration
To configure reports, select Config from the Edit menu.

The Single report options cover all ports and are overwritten each time the reports are generated. The Multiple
report options generate a separate report for each port, and each report file is appended each time the report
is generated.
For Hour reports, use the Single and Multiple droplists to select whether you are generating single or
multiple reports, or both. For each report type, select from the following types of data to include:
•

None: no report is generated.

•

Hour Data: only variables with “Hour” in the name are included.

•

All Data: all variables are included.

•

View Data: only variables that appear on-screen are included.

The External Program field is used to enter a command line to run another program after the hourly reports
have been generated. For example, you can use this to run a batch file that performs custom report
processing. The Test button causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your choices are:
•

None: no report is generated.

•

Day Data: only variables with the words “Day” or “Raw” in the names are included.

•

All Data: all variables are included.

•

View Data: only the variables that appear in the Port Monitor window are included.

Likewise, the External Program field is used to enter a command line to be executed after the daily reports
have been generated.
The Update Time option allows you to set the rate at which the port information is obtained and the
calculations performed. There is a trade-off between Port Monitor efficiency and response time. If you are
using Port Monitor to view the port activity on the screen, you may want to set the update time to 1 or 2
seconds, so that the screen is updated frequently. If you are concerned about the monitor program using CPU
resources, set this to a higher value, (6 to 20 seconds) in order to decrease the time required by the program to
perform the calculations and update the screen.
If Port Monitor is left active to generate reports, minimizing or reducing the display area of the program will
help reduce the CPU overhead of updating the screen.
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Port Monitor Files
Port Monitor creates and uses the following files:
•

portmon.vew

•

calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting with the appearance of the
monitor screen, you can use the File menu Save option to save your customized layout in another.vew file. You
can retrieve this file later by using the File menu Open option, or you can use the Edit menu View Default
option to retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour in a binary file named calcs.dat. This
enables you to halt Port Monitor execution without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are saved in this directory,
under the following names:
•

hall.txt — hourly single report

•

dall.txt — daily single report

•

hcomx.txt — hourly multiple reports, where x is the port number

•

dcomx.txt — daily multiple reports, where x is the port number

Caution: Since multiple reports append new data each time they are written, the multiple report files grow in
size. It is up to you to delete them periodically.
Some safeguards are built into the program to avoid filling up a hard disk drive due to growing report files.
The monitoring program stops writing additional data to the multiple reports if they reach a size of 2 MB.
Also, the program will not write out data files to the disk drive if the spare room on the drive is less than 2
MB in size.
To view or edit an hourly or daily report, use the Edit Report option on the File menu, or use a system tool
such as NOTEPAD.
For more information, see the Port Monitor Help file.
Port Monitor Variables
The following table lists Port Monitor variables.
Port Monitor Variable List

Variable

Description

Open

Open status, on if open, off if closed.

Cts

Input CTS pin status.

Dsr

Input DSR pin status.

Cd

Input CD (carrier detect) pin status.

Rts

Output RTS pin status.

Dtr

Output DTR pin status.

TxTotal

Total bytes transmitted.

RxTotal

Total bytes received.

TxCPSInst

Instantaneous average of transmit characters per second.

RxCPSInst

Instantaneous average of receive characters per second.

Errors

Total hardware receive errors (parity, framing, and overruns.)

TxMinCPS

Last minute average of transmit characters per second.

RxMinCPS

Last minute average of receive characters per second.

TxCPSMinAvMax

Peak TxCPSInst for the last minute.

RxCPSMinAvMax

Peak RxCPSInst for the last minute.

TxCPSHourAvMax

Peak TxMinCPS for the last hour.
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Port Monitor Variable List (Continued)

Variable

Description

RxCPSHourAvMax

Peak RxMinCPS for the last hour.

TxCPSDayAvMax

Peak TxMinCPS for the last day.

RxCPSDayAvMax

Peak RxMinCPS for the last day.

TxTotalRaw

Total number of transmit bytes raw data from the driver.

RxTotalRaw

Total number of receive bytes raw data from the driver.

TxMinCnt

Count of transmit bytes sent in last minute.

TxHourCnt

Transmit bytes count sent in the last hour.

TxDayCnt

Transmit bytes count sent in the last day.

RxMinCnt

Receive bytes count sent in the last minute.

RxHourCnt

Receive bytes count sent in the last hour.

RxDayCnt

Receive bytes count sent in the last day.

TxMinCntWrk

Transmit bytes count sent in this minute.

TxHourCntWrk

Transmit bytes count sent in this hour.

TxDayCntWrk

Transmit bytes count sent in this day.

RxMinCntWrk

Receive bytes count sent in this minute.

RxHourCntWrk

Receive bytes count sent in this hour.

RxDayCntWrk

Receive bytes count sent in this day.

TxCPSMinAvMaxWrk

Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.
TxCPSDayAvMaxWrk

Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.
RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.
RxCPSDayAvMaxWrk

Peak RxHourCPS for the current day.

CDRuns

Carrier detect turn-on count.

CDDayRuns

Carrier detect turn-on count in the last day.

CDDayRunsWrk

Carrier detect turn-on count in the current day.

CDRunTime

Time in seconds carrier detect has been on.

CDHourRunTime

Time in seconds carrier detect has been on in the last hour.

CDDayRunTime

Time in seconds carrier detect has been on in the last day.

CDHourRunTimeWrk

Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk

Time in seconds carrier detect has been on this day.

StatusFlags

Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts

Raw count of total transmit packets sent.

RxPkts

Raw count of total receive packets sent.

OverrunErrors

Total count of receive overrun errors.

FramingErrors

Total count of receive framing errors.

ParityErrors

Total count of receive parity errors.

OverrunErrorsRaw

Total count of receive overrun errors, from the driver.
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Port Monitor Variable List (Continued)

Variable

Description

FramingErrorsRaw

Total count of receive framing errors, from the driver.

ParityErrorsRaw

Total count of receive parity errors, from the driver.
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Using the Device Advisor
You can use the Device Advisor to determine the following information:
•

Summary of the device status

•

The MAC address of the network interface card (NIC)

•

The Adapter ID string

•

The RocketPort Serial Hub Si MAC address

•

Detailed state of the RocketPort Serial Hub Si

•

Total number of successful load attempts

•

Total number of devices on the network

•

Transmit statistics, such as the number of:

•

-

Frames out

-

Packets to device

-

Retransmitted frames

Receive statistics, such as the number of:
-

Frames accepted

-

Frames passed on

-

Packets from device

-

Out of sequence frames

Note: For detailed information about the fields in the Device Advisor, use the on-line help available in the
application.
Use the following procedure to access the Device Advisor:
1. Right click on the My Computer icon and select Properties.
2. Click on the Device Manager tab.
3. Expand the Multi-function adapters listing and select the RocketPort Serial Hub you want to monitor.
4. Click the Properties button.
5. Click on the Device Setup tab.
6. Click the Configure button.
7. Make sure the RocketPort Serial Hub Si is highlighted and click the Properties button.
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8. Click on the Device Advisor tab.

The Device Advisor screen appears and provides you with information that you may find useful.
For more information about the fields on the Device Advisor screen, use the on-line help in the application.
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Device Advisor Driver Messages
The following tables provide information about device driver summary messages and reported state
messages.
Driver Summary Messages
Message

Description

Unintialized

RocketPort Serial Hub Si has not been installed correctly.

Unable to contact the RPSH-Si
driver

The RocketPort Serial Hub Si driver is not installed or is not responding
to Device Advisor requests.

Unable to contact a Network
Interface Controller (NIC)

The server NIC card may not be installed, may be malfunctioning, or may
not be bound to RocketPort Serial Hub Si.

Cannot detect network

No inbound traffic of any sort is detected. The RocketPort Serial Hub Si
device may be inoperative or you may have a network cabling problem.

Cannot detect any RPSH-Si.

Network traffic is being received, but not from a RocketPort Serial Hub
Si device. Check the network connections and verify that the RocketPort
Serial Hub Si device is powered up.

Cannot detect RPSH-Si with
specified MAC address.

Network traffic is being received from a RocketPort Serial Hub Si device,
but not the one specified in Device Setup. Check the device to make sure
that you are using the correct MAC address in Device Setup, and check
the Main Setup window to verify that you are working with the correct
device.

Either the RocketPort Serial Hub Si device in question is not assigned to
RPSH-Si device with specified
this server, or it is not assigned to any server, or it has been configured for
MAC address was detected, but is
this server but the configuration has not been saved. If the latter, return
not configured for this server.
to the Setup window, save and exit, and restart the server
RPSH-Si device detected and
configured for this server, but is
not yet assigned to this server.

Either the RocketPort Serial Hub Si device is currently being controlled
by another server or the device power has been cycled and the device is
waiting for a server to acquire it.

RPSH-Si detected, initializing.

The server has acquired the RocketPort Serial Hub Si device and is
downloading the control program. The device will be available shortly.

The RocketPort Serial Hub Si device appears to be installed correctly and
RPSH-Si responsive, but no data active, but no data traffic has been sent or received since the last time
traffic exchange since last inquiry. you clicked the Refresh button. If there should have been traffic, check the
RocketPort Serial Hub Si port configuration and external cabling.
RPSH-Si responsive; data traffic
received, but nothing sent since
last inquiry.

Similar to above, except the RocketPort Serial Hub Si device has received
data successfully.

RPSH-Si responsive; data traffic
sent, but nothing received since
last inquiry.

Similar to above, except the RocketPort Serial Hub Si device has sent
data successfully.

RPSH-Si active.

Normal state: the RocketPort Serial Hub Si device is installed correctly
and active with data traffic.

Poor connection to RPSH-Si.

This message displays if retransmissions occur, frames arrive out of
sequence, or more than 2% of the total packets arrive out of sequence.
This generally indicates a cable, connector, or LAN termination problem.

Counts reset.

This message displays immediately after you click the Reset button.
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Driver Reported State Messages
Message

Description

Invalid

An illegal RocketPort Serial Hub Si state has been detected. Reset the RocketPort Serial
Hub Si device.

Init

This is the normal state for undetected and inactive RocketPort Serial Hub Si devices.

InitOwn

The server has acquired the RocketPort Serial Hub Si device but has not downloaded the
control software.

SendCode

The server has acquired the RocketPort Serial Hub Si device and is in the process of
downloading the control software.

Connect

The server has completed the download and is completing initialization.

Active

The normal state for a RocketPort Serial Hub -Si device that is attached to an NT server
and is ready for data traffic.

Not found

The specified MAC address is not configured on this NT server.

Undefined No RocketPort Serial Hub Si devices are configured on this NT server.
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Technical Support
Comtrol has a staff of support technicians available to help you.
You should review Troubleshooting and Using Comtrol Tools and run through the diagnostics before calling
Technical Support.
Note: The web site has On-Line Technical Support available.
In addition, please have the following information available.
Support Call Information
Item

Information

Hardware Type
Hardware Serial Number*
MAC Address* (if using MAC addressing)

00 C0 4E 06 ____ ____

Operating system type
Driver part number and revision level
Server computer make, model, and speed
Other network devices and network (MAC)
addresses
Devices connected to the RocketPort Serial
Hub Si
*

The hardware serial number and MAC address can be found on printed tags on the bottom panel of the
unit.

Comtrol supplies a self-adhesive label with each RocketPort Serial Hub Si unit, which you can use to record
the serial number and network address. If the RocketPort Serial Hub Si unit is not in a readily accessible
location, check to see if this label has been filled out and posted elsewhere (for example, near the server
console.

Comtrol Corporate Headquarters
Internet URL: www.comtrol.com
FAQ Online Help: www.comtrol.com/coperate.htm
email: support@comtrol.com
FTP site: ftp.comtrol.com
FAX: (763) 494-4199
Phone: (763) 494-4100

Comtrol Europe
Internet URL: www.comtrol.co.uk
email: support@comtrol.co.uk
FAX: +44 (0) 1 869-323-211
Phone: +44 (0) 1 869-323-220
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Disclaimer and Copyrights
Copyright © 2000. Comtrol Corporation.
All Rights Reserved.
First Edition, March 21, 2000
Comtrol Corporation makes no representations or warranties with regard to the contents of this guide or to
the suitability of the Comtrol products for any particular purpose. Specifications subject to change without
notice. Some software or features may not be available at the time of publication. Contact your reseller for
current product information.
Trademarks
RocketPort is a registered trademark and Comtrol is a trademark of Comtrol Corporation.
Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation.
Citrix and WinFrame are registered trademarks of Citrix Systems, Inc.

Other product names mentioned herein may be trademarks and/or registered trademarks of their respective
companies.
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